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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Warning/Disclaimer:

SINCE WE HAVE NO CONTROL OVER EQUIPMENT, COMPONENTS, DATA
HANDLOADING TECHNIQUES OR ANY OTHER VARIABLES THAT MIGHT BE
USED WITH THIS PROGRAM, NO RESPONSIBILITY IS IMPLIED OR ASSUMED
FOR ANY RESULTS OBTAINED THROUGH SUCH USE.

WE SPECIFICALLY DISCLAIM ANY AND ALL LIABILITY, INCLUDING
CONSEQUENTIAL DAMAGES OF ANY KIND WHATSOEVER, WHETHER OR
NOT ANY SUCH DAMAGES ARE DUE TO USER’S NEGLIGENCE OR BASED
UPON STRICT PRODUCT LIABILITY OR PRINCIPLES OF INDEMNITY OR
CONTRIBUTION. THE INDIVIDUAL MUST ASSUME THE ENTIRE RISK OF
USING THIS PROGRAM AND ANY RESULTING DATA.

In this documentation, the naming of other manufacturer’s products occurs exclusively for
information purposes. This represents no trademark misuse.

Refer to QuickLOAD User’s guide for complete information on the software license agreement,
applicable laws and regulations.

No part of this document may be copied, reprinted, reproduced or transmitted in any forms or by
any means, electronic, mechanical or optical, for any purpose, without the author's express
written permission.

Due to continuous program updates, information in this document is subject to change without
notice and can differ from the version of the program supplied. Be advised that the current
version of QuickTARGETUnlimited may contain useful functions that this manual does not
reflect.

All QuickTARGETUnlimited functions are available through standard menu item selections
(review the QuickLOAD Unlimited manual for information on choosing menu items).

© Copyright 2002 - 2010, Hartmut G. Broemel, D-64832 Babenhausen / Germany, January
2010. Worldwide all rights reserved.
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Program Installation

QuickTARGET Unlimited program must be installed together with QuickLOAD to and run from
a hard disk drive. It is automatically installed during installation of QuickLOAD and cannot be
installed separately.

For Program installation instructions, refer to the appropriate section of QuickLOAD
Manual.

Page 3



QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Contents
Warning/Disclaimer:.....cociiiimimmaimsmesmermmesmarsmasmarssmasnassssassssassasnssassassssasnasnnss 2
Program Installation........cccoimimmeimmsmmmsmmemmeimssimssmmesmmsnsssssssnssnnssnssnsssnnsssnssnnsnns 3
FOr@WOIrd . ..icuieurmasnannasnasmasmasmasmasssssnssnssnssnasnassassassassassnssnssnssnnsnnssnssnssnssnssnssnnsnnsnns 5
Starting QUickTARGET unlimited .......coiciimmmmmnmmmimmmemsmsmsmemeasnss 6
Important keyboard commands......ccicurermummsmmsmmemmasmemmsmssssssssssnamamaaanns 6
Coordinate System of QUICKTARGET Unlimited............c..ccoreireisnnsrnnsrnsssnssnnsnes 7
Main WiNAOW ..cuieiciieimieiieimsremarssmasmamssmasmasssmassasassassssssssssssasnsssssasnsssssasnssasnasnnsas 8

Main Menu Bar.......coiremmeimmsimessmsssmesmmesmnesmsssmsssmsssmassnsssnsssssssssssasssnsssnssnnssnnsnnns 9
= o T ] 9
Print Selection WindOW......coccireimamasmasmmsmmssmssmasmasmassssssssnssssssassassassassnssnnss 10
Menu Auxiliary Calculations.......ccoirmrmrmimenminemesrsmssnsnese s 11
Menu OPtioNS....ccireireiresrasmessssssssnsssesnasrassassassssssssnssnsssassassassnssnssnssnnssnsnnsss 14

User's Settings of UNits ........ccoiiiminmmmmmmesmmeimmsimssmmsmesessssnsssssssssnsssns 17
Wind-Rose WiNAOW.....ccicureusmssmasmasmamsasmssmassssssssnssnsssassassasssssssssssnsssnssnssassas 18

Gun Sight-In Conditions WindOW.......ccieummsmmammesmasmasmsssssssssssssssnsssassassasssssnssnnss 19
Trajectory Table Conditions WindOW .........couseimmammmssmassmesnssssssssssssassnsssssssnssnnns 24
Displaying ReSUItS....c.icirmirmmmmmmammammammammasmasmssmssmsssssssssnssnassassassassassnssnssnnsnnsnnsnnns 27
Menu CoPY t0... correirermreimarsmasmarssmassssasmassssasnassssassasassassssassasnssassasnsnnsnnsnns 27
Menu Output OptioNnS......corcuremremresrnsrsssssssssssssassasrassasssssnssnsssassassnssnssnssnnss 27

0 LT 1 o ) 28
Trajectory Table.....coicureirmmmmmanmemnasrammesmssssssssssssnesnassasmassassnssnssnsssnsnnssnsnnns 29

Changing Graph's APPearancCe ....cuiuresresrssrsasnassassassassasssssnssssssassnssassassassnnss 30
Graph WindOW .....ccceiremmeimssmssmsssssssssssssessasmsssssssssssssssssssassassasssssnsssnssnssnssns 30

Examples of Different Graphs in the Order of Menu..........coccviveimrenernaen. 33
Drag Table Graph .....ccicuremmsmmemmasmammammasssssssssssssssassassassssssssssssassassassnssnssnnss 33
Drop in Ground-Fixed-Frame ......coicurssmmsmmesmssmssmasmssssssssssssnsssassasnasssssnnsnnns 34
Path in Ground-Fixed-Frame.......c.ccoimmmmmemmanmaimamesmmsmsssmssmssmasnassassassnsnnns 35
Path versus Line Of Sight........ccoiciiimmimmmimnmiessen s 35
Velocity Graph.....coicurireiremssmmssmsmmssmemmemmssmsssssssssssssssasmassassssssssssssssnnsnnsnnns 36
Energy Graph ...c.cciicirireimeimssmssmssmmssmesmssmasmssmssssssssssssnssssssassassassassnssnnsnnsnnsss 36
Time of Flight.....c..ccoiiiiiiiiin i ssssnmssnnsses 37
MOA Elevation Correction to Zero-IN......ccicesrmumresssessssssssssssssasssassnnssnsssnns 37
MOA Azimuth Correction to Zero-IN .....c.ccuremrmrmsmmsssssssssassassassassssssssnnsnnns 38
Top View: Azimuth Deflection......c..ccirimemmirmmmmmmsmmmsmmssmsmemsmsmssssssass 38

Different Examples of Graphs.........coiiimimimimiminms s 39

APPENDIX .euicuitauinasmnasmnssmasimassnssmnssmsssmsssssssnsssnssssssssssssssssssnsssssssassnsssnnssnnssnnsnnns 42
Drag Table FileS.....ccitiramrasmammmsmmusnsmnsssassassasnasmasssssnsssssnsssnssnssassassnssnssnnsnnsnnns 42
Wind Profile Files.....coiucurmummmummmsmmemmesmmsimsssmnssmsssmassmssmnssssssssssnssssassnsssnsssnsssnns 43
[ 3101 [T T = T o 3 45
List of INlustrations ......cccccimimeiiiriresr s s s e e e nn 46



QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Foreword

QuickTARGET Unlimited is linked to QuickLOAD, our powerful Interior Ballistics Predictor
Program. This version provides accurate and complete solutions to many “real-world” external
ballistic questions.

At this time of writing, the program is still in the beta-phase and is added together with
QuickLOAD and QuickTARGET to the CD. The addition "unlimited" has been used because the
program has no restrictions like maximum ranges. It represents a Point-Mass Model or 3-
Degrees-of-Freedom approach to the solution of exterior ballistics equations of motion.

Maybe a future version will expand this program to 4-DOF (Degrees-Of-Freedom) capabilities.
This depends on finding a practical way to enable the user to make an estimate of all necessary
coefficients needed for such calculations.

The program offers various drag tables together with the ability to use projectile specific drag
tables read from external files without the need for Ballistic Coefficients.

It uses the same bullet files as QuickLOAD and QuickTARGET, but due to extensions, it is
practical to edit bullet files under QuickTARGET Unlimited, otherwise some data entered by QT-
Unlimited may be lost in bullet file.

The program provides more exact trajectory prediction at long ranges and is not restricted to
very flat trajectories. One should know that programs maximum predicted horizontal ranges for
spinning bullets are slightly too long, because a yawing bullet creates somewhat more drag and
the maximum range will be slightly shorter. While the maximum vertical range calculation of the
trajectory to vertex is very exact, the return from vertex to ground level is not, because of
unknown drag of a bullet that returns base forward.

A 3-DOF model and even a 4-DOF model are not able to calculate precisely trajectories in the
so-called upper group of angles for spinning projectiles (above 50 degrees angle of departure).
Such calculations have to be done by solving 6-DOF equations of motion, which represent also
only a semiempirical approach to the solution of exterior ballistics. However, the indeterminate-
ability of many initial conditions and aerodynamic coefficients, which are required as input is far
beyond normal user's capabilities. Even if aerodynamic coefficients are available, there are
more uncertainties, especially at barrel exit, that would affect trajectory prediction. Complete
and accurate solutions to exterior ballistics projectile motion involves the solution of equations of
fluid flow on the projectile, this is beyond the capabilities of available computers.

The user should be aware that the program distinguishes between Sight-IN conditions
and Trajectory table conditions. For the beginner both conditions should be set to equal
data, otherwise he will wonder about the results and cannot interpret them correctly.
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Starting QuickTARGET unlimited

Double-click on program icon:

QuickTARGET Unlimited

After a few seconds of load and check time a text window with useful hints and warnings
appears. Please read this text carefully. When you understand what it says, select the
appropriate button, according to your decision.
QuickTarget Unlimited > initial setup R
QuickTarget Unlimited> V0.1 f DLL: 1.00 -SN# 111116
Licensedto Hatmut G. Broemel, TEST

2 Copyright 2001-2007 H.Broemel, Babenhausen, Germany

3-DOF Exterior Ballistics Program

This program calculates the trajectories of projectiles using varous drag functions. The C1 ballistic
coefiicient is used by the major manufacturers of sporting ammunition to calculate the trajectories of most
sporting bullets. The ballistic coefficients listed in handloader's manuals are based on the 'G1' tables.

Other coefficient tables such as G2, G5, G7, G etc. exist and had been used for same military projectiles but are now
obsaolete. In contrastto G1 they need different ballistic coefficients which are notfound in handloader's manuals.
The G1 function produces useful but not pedect trajectory data for most sporting projetiles, so far BC's represent
the actual prajectile. Found balls, shotgun slugs. airgun pellets and rimfire- and wadcutter bullets need specific
coefficent tables. few are provided with this program. Today's professional exterior ballistic programs use projectile
specific drag coefficients. A few for 30 cal. and .224 cal. are included.

DISCLAIMER
This software is licensed >as is€ and without warranties as to performance or merchantability.

Our entire liability shall be at our option, either return of purchase price or replacement of the software. Since
we have no control over the components and equipment which may be used with this program, no responsibility
is implied or assumed for results obtained through its use. The user must assume the entire risk of using program
and data. To the maximum extend permitted by applicable law. in no event shall the seller or manufacturer be
liable for any damages whatsoever {including without limitation, direct or indirect damages for personal injury
or death, business losses, or any other pecuniary loss) arising out of the use of or inability to use this software.

YWarning: This computer prograrm is protected by copyright laws and international treaties.
Unauthorized reproduction or distibution or reverse endineeting of this prograrn, or any portion of it, may
resultin severe civil and criminal penalties. and will be prosecuted to the maximum extend possible under law.

If you do not agree to this terms, leave this program by pressing the EXIT - Button !

Exit Program |

Picture 1: Start and Disclaimer window

The license agreement and important advisories, which you must necessarily read, are
found on the first pages of the QuickLOAD manual. For additional timely and important
information, please review the readme.txt file on CD.

If the program does not start or aborts without providing an error notification, the program code
could be corrupted (perhaps by a virus). The program tests for such corruption and usually
provides a Checksum Failure error message. In either case, uninstall program and try to
reinstall it from the installation disk. Error warnings during file loading (QLOADFW.BUL,
QLOADFW.INI or QTF.set) indicate that the reported file is corrupt or does not exist in the
program directory.

Important keyboard commands
To activate main menu line, press keyboard combination < ALT > + < PgUp >.
To activate and jump past opened windows, press keyboard combination < Ctrl > + < Tab >.

To select or bypass input fields, press < Tab >. “Arrow” (cursor control) keys also select input
fields. To activate drop-down fields, press keyboard combination < Alt > + < | > (e.g.
Projectile). Program exit is initiated by pressing< Alt > + < F4 >,
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Coordinate System of QuickTARGET Unlimited
Y
A

il

Trajectory Height

Angle of Deflection

Lo |

Picture 2: Ground-Fixed Frame of Coordinates

The x-y plane lies in the direction of firing. Between muzzle velocity vector vo and x-z plane
spans the angle of departure ®, . The angle of impact into x-z plane is ®. Forces on projectile
are Drag Force vector F , velocity vector v and Gravity vector g.

Y
A

Trajectory Height

Picture 3: Gunsite Angle
Gunsite angle is defined by target position. Target center is assumed to be in the x-y plane. The
line between target center and muzzle forms an angle to x-axis : the Angle of Gunsite. The x-z

plane is horizontal to Earth's surface; the origin of x-z plane is located at gunsite altitude above
sea level.
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM
When the user accepts the agreement window, this window opens:

Main Menu bar Main Window

FHQuickTarget Unlimited> [test.sc = |El[i]
Options

|| Sight-In SetupWindow || Tableygetup Window ResulgiWindow Calchyate

Calculate
Trajectory
I
Show
Results
I
- Show
. Trajectory
"\ Table
Settings

Receive Data from
. QuickLOAD

Show
Sight-In
Settings

, T
Edit
Bullet

E’EQui_ck'::‘ A Quick = ml 3|

Picture 4: Main Window

This is where the user inserts all basic gun and load data.

This data entry window allows specification of all data that is essential to trajectory table
calculations. The user can enter useful values into all fields. The button Receive data from
QuickLOAD retrieves values entered in QuickLOAD (when that program is running, or the
latest data QuickLOAD has produced.).

NOTE: Input character of decimal point is the keyboard ‘period” character, even when user
presses a comma it is converted. This is independent of Windows Operating System "Locale"
settings.

Some fields for numerical inputs verify lower and upper limits for data entry. Violation of these
limits produces a light red background color for "too high" or light blue color for "too low" value
in the entry field. However, since this program cannot check every keystroke for simply incorrect
entries, it is possible to run calculations with spurious input values.
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Main Menu Bar

@QuickTarget Unlimited> [test.set] = IEI | x|
CThile ! Auxiliary Calculations | Options

m Sight-in Setup Window Table Setup Window Results Window Calculate

Picture 5: Main Menu Bar

So far the graph Window is not in foreground, the main menu bar shows the above
configuration. Main menu line contains sub-menus: File, Auxiliary Calculations and Options.

Menu File

7R QuickTarget Unlimited> [testset]

File Auxiliary Calculations Options

Calculate Ballistics

Save trajectony data Cirl=5
Load trajectory data

Printer setup
Select Printer Font
Prinit

What to Print ?

Set language to 4

Exit program Alt+F4

0 CAWINAPPS\wbhAOT_MPMidata\useritest set
1 CAWINAPPS\vb5A\OT_MFPM\data\useriotto.set
2 CAWINAPPS\wbh\OT_MPMidata\useriwilli.set
3 CAWINAPPS\vbB\OT_MPM\data\user\hugo.set

Picture 6: File Menu
Clicking to the word File or pressing keys, ALT-F invokes the File menu. It contains the
following menu items:
s Calculate Ballistics:
> Starts calculation, same effect as command button Calculate in the icon bar. After
finishing calculation, a trajectory table or a graph window is displayed. After opening of
the output window, the menu changes to enable the user to set up graph settings.
Save trajectory data
» So far, valid data exists; the file save window is opened. User may specify an
appropriate file name and save the settings and data of the Sight-In- and in the Table
Setup Window.
« Load trajectory data
» Opens the open file dialogue window and user may select one of previously saved data
files.
% Printer Setup
» Opens the printer dialogue window to select and specify printer properties.
% Select Printer Font
» Opens font dialogue to specify a font type and size for printing data and trajectory table.
s Print
» Opens a printer selection window and prints selection.
< What to print?
» Opens print selection window where user my specify what he wants to print

7
0.0
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Print Selection Window

QuickTarget Unlimited > Print Selection

—What to Print ? —aplit Pages

[v Trajectory Table (" One Graph perPage
[v" Trajectoryto LOS % (& Two Graphs per Page
[v Trajectary in GFlx Coordinates (" Three Graphs per Page
v Side Deflection to LOS

[v “Yelocity Graph

[v Show Multiple Traces when Availakle

Picture 7: Print Selection
Here the user may specify what he wants to be printed. The main data is always printed and
cannot be deselected. For normal printouts, we recommend to set the printer's sheet orientation
to portrait.
< Set Language to
» Select a language for the program windows. A sub menu opens showing the available

languages.

|ET Auxiliary Calculations Options
Calculate Ballistics Window I
save frajeclory datd Cirles

Load trajectory data

Frinter setup
Select Printer Font
Brint

What to Print ?

Set lanquage to 4 German

Exit program Alt+F4 v English
} Erench
0 CAWINAPPS\vb5\QT_MPM\data\useritest set Fussian

1 CAWINAPPS\vbH\OT_ MPM\data\useriotto. set
2 C:A\WINAPPS\vb5\QT_MPM\data\user\willi set .
3 CAWINAPFS\vbOAOT_MPMidataluserthugo. set

Picture 8: Sub Menu Languages

7

s EXxit Program
» Close QuickTARGET Unlimited's windows. Terminate program. Also invoked by key
ALT-F4.

» The names of the previously save data for easy access to frequently used data. Up to
nine entries are displayed.

Page 10



QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Menu Auxiliary Calculations

get Unlimited>= [test set]

| Auxiliary Calculations Options
[}

Calculate Maximum Yerlical Range

Calculate Maximum Horizontal Range

Calculate Point Blank Range

Conversion of BC to Drag Model

Calculate BC from 2 Yelocities and Distance

Calculate Muzzle Yelocity from Chrongraphed Yelocity
Calculate Target Position

Picture 9: Menu Auxiliary Calculations

This menu provides useful calculations not provided by normal trajectory calculations.

% Calculate Maximum Vertical Range
» The program tries to calculate the maximum altitude the projectile reaches by firing
vertical into the air. While the results for ascending path represent the optimum what is
possible (no significant yaw assumed, drag and BC's correct), the falling data are
necessarily not very exact for spinning projectiles, because it will fall in most cases with
base forward. "Base forward" drag characteristics are unknown and only a rough
estimate of using double drag for falling part is used.
% Calculate Maximum Horizontal Range
» The program calculates the maximum horizontal range in muzzle plane. Program
assumes no yaw and results represent maximum possible distance, so far, drag data
and BC's are correct.
% Calculate Point Blank Range
» A window opens to specify the vertex of trajectory above (and below) Line Of Sight,
sometimes named vital height. Program calculates zero-range to obtain desired point-
blank-range. Results can be automatically transferred to Sight-In window.

QuickTarget Unlimited> Point Blank Range

Yital Height above and below LOUE. IH in

Calculate optimum Sight-ln range for conditions specified in
oight-In Setup form,

¥ Be-Assign calculated Sight-ln range to Sight-n form

Exit

Suggested Point Blank Range setlings:
Set Zero Range to - 1592 m
Maximum Foint Blank Range : 185 m

Picture 10: Maximum Point-Blank-Range

Page 11



QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

% Conversion of BC to Drag Model
» Opens a window to calculate new BC valid for other drag model.

QuickTarget Unlimited:> BC Conversion

—from BC 1:
| G1-sAAMI Standard mud% ~|
B |.5EIEI Cd1| 0519
—to BC 2:
|G5—Sh|:|rt 75" Boattail-6.19 cal tangent ogive LI
— new BC's Atmosphere
| Standard 1CAC |
Barometric Pressure |01 245 ||'r*.Ei=|!
Relative Humidity |0 [%
Temperature |'IE 0 I":
Altitucle |0 I
BCZ| .304 CdZI 0316
\elogity 515 m¢sec

Exit |

Calculate

Picture 11: Convert BC to other Drag Model

» FRAME from BC 1

= Select drag model for existing BC

= Nextto BC 1, enter a BC using specified drag model

= Drag coefficient Cd1 is shown after selecting velocity
» FRAME to BC 2

= Select new drag model

= Select Atmospheric Conditions

= Select Velocity
» Press Calculate

= BC2 will display new BC, Cd2 will display new drag coefficient
> Exit

= Button closes window
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

% Calculate BC from two velocities and distance
» Use two velocities at two different distances to calculate a BC. Drag model and
Atmosphere from window Sight-In is used

QuickTarget Unlimited> BC Calculatiory 5
First Welocity 2785 Iﬁ,’sec

Second Velocity !ESEEI Iﬁ,’seu:

Distance |1 ao Iyd

Atmosphere and Drag Model from Sightn Form is used.

Exit | ‘ Calculate I

BC |.-4E|1?

Picture 12: Calculate BC from 2 Velocities

Enter both velocities and distance, press Calculate button. BC is calculated. There is no need to
care for lower and higher velocity entry window. Press Exit to close window.

% Calculate Muzzle Velocity from Chronotach Velocity
» Enter chronotach velocity and distance to screens center
» Press Calculate to calculate muzzle velocity. Drag, BC and Atmosphere settings from
window Sight-In are used. User may select Reassign box to transfer velocity to Sight-In
window.
» Press Exit to close window

QuickTarget Unlimited:> Muzzle Yelocity
Chronotached Yelocity |2455 ﬁfsec
Distance from Muzzle to Screens |1 10 Ed

Atmosphere, BC and Drag Model fram Sight-In Form is used.

[T Be-Assign calculated Velocity to Sightn form

Exit | . Lalculate

Frojectile Welocity at Muzzle Exit |31 B1 fifsec

Picture 13: Muzzle Velocity from Chronotach Velocity

< Calculate Target Position
» Using the settings of gun position (Latitude, Longitude, firing direction and Sight-In range
from Sight-In window calculation returns Latitude and Longitude of target.

QuickTarget Unlimited > Target Positio x|

Latitude - of Target= 43 deg, 23 min, 31.6043 sec
Longitude of Target= 10 deq, 59 min, 47.0492 sec

Data input:

WGS-84 Geoid (Vincenty algo.)
Latitude of Gunsite (South=negative)
Longitude of Gunsite

Direction of Firing (Compass deg)
Sight-In (Zero) Range
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

Menu Options

Options
v Tooltip help enabled
System sound on
v Coriolis Effect on
Edit Projectile
Setup Screen Font
Conversion of Units
Maximum Projectile Drop below Sea Level

Picture 14: Menu Options

Tooltip help enabled

» Enables or disables the pop-up window displaying help to each entry field

System sound on

» Enables or disables warning beep. No sound is played.

Coriolis Effect on

» User may switch on/off Coriolis effect within calculations caused by rotation of Earth. In
reality, it is not possible to switch it off.

Edit Projectile

» Edit Projectile window opens. Because QuickTARGET Unlimited uses 6 BC's, projectile
files should be edited using this window instead of QuickLOAD's or QuickTARGET's
windows. While QuickLOAD/QuickTARGET work with the newer data, they will remove
new BC information from the files. QuickTARGET Unlimited can use older files too.

=

QuickTarget Unlimited> Projectile Edit"
— Projectile Data
(358, 275, SRA SPET 2860 Ll

BEET BC 2 EIC_3 BC 4 BC._5 BC &
[ 364 | 377 | ae0 | 384 | |

[ 762 | 610 f 488 || 0 | jrm/sec
el l “Wel2 el d Yl 4 “alh
Drag Model to be used

[G1-5AAMI Standard madel =] a1
Prajeciile Weight {225 far
Frojectile Feference Digmeter I.BSB |in

= Additional Properies

Prajectile Length {1.157 fin
Boattail Length/Hollow Base Depth l.1 294 iin
Boattail{Hollow Base Large Diameter l.35?9 |in
Boattail/Hollow Base Small Diameter |.2?E|9 |in

Base TaperAngle-Full/Half 187 7 8.4~
Shot Start Fressure !ZEEI |bar

(& Boattail " HollowBase {~ FlatBase

Cancel I Celete | Save |

Picture 15: Edit Projectile Window
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QuickTARGET Unlimited - EXTERIOR BALLISTICS PROGRAM

This window serves to alter projectile data or to add projectile data.
« FRAME Projectile Data
» Drop-Down Box containing all projectiles of actual loaded file. Press triangular down-
arrow on right side of field to open selection list.
» You may manually enter appropriate BC's into BC-fields and corresponding
boundary velocities.
« Drag Model to be used
» Drop-Down box with available fixed drag models to which the entered BC's relate.
» Projectile weight
= Enter mass of projectile
» Projectile Reference Diameter
» Enter projectile diameter for small arms bullets, caliber (bore) diameter for
projectiles with rotating bands.
« Additional Properties
» Projectile length
» Boattail Length/Hollowbase depth
» Boattail/Hollowbase large diameter
» For Boattail diameter at shank-to-boattail transition, for hollowbase large
diameter at base of projectile.
» Boattail/Hollowbase small diameter
= For boattail the diameter at projectile's base, for hollowbase diameter at bottom
of hollowbase inside projectile.
» Base Taper Angle full/half, output only
» Shot Start Pressure
= Shot start pressure for use with QuickLOAD program
» Option Buttons

=  Boattail
= HollowBase
= FlatBase

e Set according to shape of projectile
% Buttons

» Cancel
» close window without making changes
» Delete
= Select a projectile in the drop-down box and press Delete to delete data set also
from file
» Save

= Save entered data to projectile file.

% Setup Screen Font
» Windows font can be changed using this menu point. A font selection window opens to
let you select to your own choice. Using too large font causes readability problems
because text will be truncated or cut off.
% Conversion Of Units
» A small window opens containing a cross-calculator for most frequently used units.

Quick Target Urlimited > Conversic

Conwversion of ;

IGramms Q) <—> Grains (gr) ;I
and Yice Yersa,

| 9719636)  Cancel |\ 150]

Gramms (g) Grains (gr)

Picture 16: Conversion of Units

This window provides bi-directional unit conversion. It makes no difference what field or what
value is entered.

L)

%  Maximum Projectile Drop below Sea Level
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» Opens small input window. User specifies Y-ordinate below sea level where calculation
is stopped. Valid range is from —1 meter to —10000 meters. Recommended e.g. to
display shotgun pellet trajectories, which drop steeply beyond 200 yards. If the ordinate
limit is too large, the unimportant part of trajectory plot governs the grapic window, which
might be undesirable.

b ek Targat Linkimitad > iifH'}h
Trajectory In Ground-Fixed-Frame S—— Trajectory In Ground-Fixed-Frame

{Quick Taral Unlimitad> Graph

Fuooiboniibomvolsmbionbiasish s mbins sobs sabomt i b s s winh s s e i e i b Ty S LICEOTARN SRR WIS | SIS | R S R
120 140 160 180 200 0 40 80 120 160
Ranga(x) (m)

Picture 17: Ordinate limit set to -1m (left) and -100m (right)
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User's Settings of Units

The program uses user's settings of units unlike QuickLOAD and QuickTARGET.

The units are always displayed in a field right of the value field. A right mouse button click on
this unit-field pops up a unit menu. (This menu is also activated while cursor is in value field by

pressing CTRL-ARROW DOWN key combination)

ms _ | Drag Model
jhtto Bore Centerline v "3 ||:rn
o [NAPPSL
ght ta Bare Centerline z |0 fin _
ectional C
t-In Gun Canting Angle |0 [dec ™ gm & betile Pro
ight Adj MOA per Click [0.23873 MG, m (-FED
. b ; km |
. Definition Distance [100.0 l}/d 1 B
. il |
Jizplacement per Click |.250 Iln : ;
T
v Zeron Wi I
aro-n Windage too 5 el T
SightIn (Zero) Pange [15 fm :’ni Brg
Impactto Tot Centary |0 lem Il

Picture 18: Setting of Units

Example: pop-up unit window for length-units in field Height of Sight above/below bore

centerline.

User may select the appropriate unit by clicking with left mouse button on desired unit or use

key: Arrow-Up or Arrow-Down and press Enter key.

There are some exceptions:

1. The MOA units are not selectable

2. The angle's units are deg, rad and mils. When set to "deg", the user may enter decimal
degrees, and by double-clicking into the value field (or press CTRL-W key) a small
window opens allowing entering degrees, minutes and seconds. Note: because entries

are additive, you must apply to each field a minus sign for negative angles.

5

£ 07 '

aa

]

Picture 19: Deg, Min, and Sec

. When selecting Wind speed and Angle of Wind user may select unit of angle and unit

of velocity as stated above, but by double-clicking into the value field (or press CTRL-W
key) a wind-rose field opens to enter both direction and wind speed graphically.
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Wind-Rose Window

x|

b.8 mph 49,5 deq

Picture 20: Windrose Window

The windrose window enables the user to indicate wind direction and strength graphically.

The projectile in the picture points in shooting direction.

The direction of North to firing direction is shown by a yellow line and the word NORTH, as
specified under "Environmental Properties" for the gunsite position and firing direction in
Sight-In or in Table Setup window.

Wind is represented by a light blue Wind-barb, in this picture the direction is 49,5 deg from
firing direction (a headwind and crosswind component is calculated) with a strength of 6,8 mph.

The user may left-click with mouse symbol over red point, hold button down and drag wind-barb
to desired position. The position of red point relative to center of wind rose represents wind
speed. The circles on the picture show wind speed values; here from 1 to 10 mph. User may
drag red point outside of circles to obtain higher wind speeds.

The values in the upper left and upper right corners do not always show the actual wind data.
They represent the mouse cursor position or the last mouse cursor position over the grid.

Using the keyboard to move wind-barb, they display actual data; so far, mouse cursor is outside
of this window.

Keyboard commands are:

Arrow-Up to increase angle
Arrow-Down to decrease angle
Arrow-Right to increase speed
Arrow-Left to decrease speed

Enter Key or ALT-F4 to close window.

oRrON=
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Gun Sight-In Conditions Window

i QuickTarget Unlimited> Gun Sight-In Conditions =[] 1||
—Gun Dimensions Drag Model [}S
Line of Sightta Bore Centerling v iE !in iG7
Line of Sightta Bore Centerline z {0 fern |G7-Long 7 5° Boattail- 10 cal. tangent ogive >l EI
Sightln Gun Canting Angle iD ideg Sectional Density of Standard Projectile | 1.000 b sy in:
Sight Adj. MDA per Click 50.344 iMOA — Projectile Properties
Sight Adj, Definitian Distance [21 44 fim | 308.155 5. Berger M T BT G7 #30415 =] =
: . : BC_1 BC 2 BC 3 BC4 BCE BCE
Sight Adj. Displacement per Click 59.15 imm | T | | | I |
Fifling Twist Length |10 in
| ' O
Bt L e — vell Vel? Veld  Veld  Vels
SightIn (Zera) Range |300 m Projectie Muzzle Velocity[2800 firs
Bullet Impactto Tat Centery ID Ic:m BulletWEighti'l 555 igr
Bulletimpact to Tgt Centar z |III |Cm - -
- Environmental Properties
Aiming Paintto Tgt. Centery |0 [em Direction of Fiting (Compass deg) 0.0000000  [deg
Aiming Paintto Tgt Center 2 |':| |m Latitude of Gunsite (South=negative] |45 |deg
—Gunsite Setup Longjitudle of Gunsite {10.000000 [deg
Altitude of Gunsite ID |m ~Wind Settings
Gunsite Angle (up-cawnhill) |IJ |deg Load from a File —> El
Wind Speed |1 [mph
Gun Muzzle Position G x |D |m
-~ Wind Direction to Firing Direction !90 |deg
Gun huzzle Position GFIxy |D |m
3] —Atmosphere Settings
Gun Muzzle Position GFl= z IEI ICm | Standard ICAD lJ
Moving Gun Platiorm v ID |m.l’sec Barometric Pressure |!=i'i 3246 ||:’.-"
Mowing Gur Platform iy |IJ |m,."sec Relative Hurnidity |.j; |°.é
Mowing Gun Platform Yz |D |m,u"sec Air Temperature |1 B0 |‘!:'

Picture 21: Sight-IN Conditions window

Entry fields in this window from upper left to lower right:

< FRAME Gun Dimensions:

>

Line of Sight to Bore Centerline y

= Vertical distance between Line Of Sight and Centerline Of Bore. Gun not canted.
The selected units are initially used to format ordinates in trajectory graph.

Line of Sight to Bore Centerline z

= Horizontal distance between Line Of Sight and Centerline Of Bore. Gun not canted.
The selected units are initially used to format ordinates in graph "Topview"'.

Sight-In Gun Canting Angle

= Canting angle of gun while sighting in. Unusual for sight-in, but possible.

Sight Adj. MOA per Click

= Settings according to specifications of your guns sights, amount of angle per click or
scale tick

Sight Adj. Definition Distance

= Settings according to specifications of your guns sights, reference distance at which
correction value is obtained (normally 100 meters or 100 yards)

Sight Adj. Displacement per Click

= Settings according to specifications of your guns sights, amount of windage and
elevation correction per scale tick or click

Rifling Twist Length

= Enter the twist length for one full turn of the bullet. Is used to calculate spin drift. Set
to zero to avoid spin drift calculation. Use positive figures for Right Hand twist,
negative for Left Hand twist.
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% FRAME Target Setup
» Zero-In Windage too, Check Mark
=  When selected program corrects sidewards displacement of impact caused wind and
Coriolis effect. Only used when Sight-In range is specified
» Sight-In (Zero) Range
= Distance from muzzle of gun to target when sighting-in. It is not necessary identical
with zero-range because hold-on point and impact point on target have to be
considered. Setting Sight-In range to zero means no sight-in calculation takes
place-this setting is used to calculate trajectories dependent on elevation
angle (angle of departure)
» Bullet Impact to Tgt. Center y
= Vertical displacement between target center and point of impact
» Bullet Impact to Tgt. Center z
= Horizontal displacement between target center and point of impact
» Aiming Point to Tgt. Center y
= Vertical distance from Point of Hold to target center
» Aiming Point to Tgt. Center z
= Horizontal distance from Point of Hold to target center

Picture 22: Target Data Definition

s FRAME Gunsite Setup:
» Altitude of Gunsite
= Position of gunsite above or below sea level. Use at best GPS altitude data for
altitude above or below Earth geoids surface. This is also the position of the origin of
the Ground-Fixed-Frame of coordinates used by calculations. Value is also used to
determine atmospheric data from Standard Atmospheres at this altitude. While
trajectory calculation is in progress new altitude data for atmosphere and gravity is
calculated by each integration step, dependent on projectile's trajectory altitude.
» Gunsite Angle (up-downhill)
= Angle between horizontal plane and line from gun's muzzle to target's center, or in
case of "Sight-In range = 0" angle between Centerline Of Bore and horizontal plane
= approximately Angle Of Departure
» Gun Muzzle Position GFIX x
= Horizontal position of gun muzzle before (= +) or behind (= -) Ground-Fixed-Frames
y-z-plane, X-axis points into firing direction
» Gun Muzzle Position GFIX y
= Vertical position of gun muzzle above (= +) or below (= -) Ground-Fixed-Frames x-z-
plane, Y-axis points upward
» Gun Muzzle Position GFIX z
= Sidewards position of gun muzzle right (= +) or left (= -) Ground-Fixed-Frames x-y-
plane, Z-axis points to the right
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» Moving Gun Platform Vx

= Gun is moving with velocity to be specified, component of velocity in x-direction
» Moving Gun Platform Vy

= Gun is moving with velocity to be specified, component of velocity in y-direction
» Moving Gun Platform Vz

= Gun is moving with velocity to be specified, component of velocity in z-direction

% Drag Model:
» User may select a drag model of his choice

= Standard Drag Model is G1. Others like GS can be used for shotgun pellets together
with a small shotgun pellet file available in the bullet section. Because the other
models like G2, G5 etc. are based on different sectional densities than G1 (SD=1)
they seem not to be useful,. The author hopes that those other models are corrected
to SD=1, but has not found any evidence about that matter in literature.

= The small rectangle in the upper right corner shows the abbreviated name of
selected model.

= The sectional density of the reference projectile is displayed below the selection box
of drag model
= User may load Non-Standard-Drag data:

-] B

. b f=gin.

A standard windows file window is opened displaying some additional drag table files.
(I apologize for the German window, but | have no English version installed on my
computer, the English window should look similar, but with English text.)

Click here to open file
dialogue window to load a
different drag file

QuickTarget Unlimited> - Read Drag data

Suchen in; lJ dray j - ok B

#7_5mm_GP11.drg
2] 9mm_FM._8gramm.drg
|2]12_Brenneke.drg
2] 30mmXM788E1-TP.drg

2] 308-SIERRA168MK-BRL.drg |2 No9_ShotLead.drg
2] 308-SIERRA190MK-BRL.drg |2 No9Blei.drg

|#] 762mm_AKA47_8gramm.drg || Rimfire_RA4_C.drg
|2 DonMillerSphere.drg |#] Sphere_McCoyBook

4] 224-L110-BRL.drg
4] 224-M193_FM.J_55g.drg
4] 224-M193_G.drg
2] 224-M855-BRL drg
2] 224-M856-BRL.drg
: 4] 224-5109-BRL.drg
2[' ] 308-M80_G.drg
2] 308-M80-BRL.drg
2] 308-M188-BRL.drg

Eigena Dataien

Arbeitsplats

4] 50_Ball_M33.drg #]G1_Cd.drg |#|test_g.drg
4] 155mm-M483A1-BRL drg 2] G1_Gfunct.drg
4] 224-GP90-SM.drg #G1_Kd.drg

4] G1_McCoyBook.drg

2] G2_McCoyBook.drg

2] G5_McCoyBook.drg

2] G6_McCoyBook.drg

2] G7_McCoyBook.drg

2] GB_McCoyBook.drg
2]ingall_G.drg

2] Ingalls_McCoyBook.drg
|2|No7.5-ShotLead.drg

| I

- B

imgEby Dateiname: |m

Offnen I

|Drag Ge-CekKd File (*dro) |

Abbrechen |

4

Dateityp:
|| Schreibgeschitzt offnen

Picture 23: Open Drag File Window

% Proje [TenexRE0

g Plagwenex_%nlllil tain I jectil f loaded jectil bullet fil
.jjecmemlb_fsqm_ taining all projectiles of loaded projectile- or bullet file

load new projectile file
~| =& Click here to open file
BC B dialogue window to load a
= different projectile file

EC 5
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A standard Window's file window is opened displaying some additional bullet files.

QuickTarget Unlimited = L.oad Bullet File 2] x|
Suchenin; | bullets x| e«®BEckEr
|2} AirgunPellets.bul: 2] HAWK.BUL | 2] PMP BUL
|3 ALASKA BUL |#|HIRTENBERGER.BUL 4] POWELL.BUL
2] ASQUARE bul |#|HORNADY bul 2] QLOADFW.bul
2] BARNES_bul 2] IMLbul #|RCBS.BUL
%] BERGER.BUL &) IMPALA bul \# REICHENBERG.BUL
% BLASER.bul 2] JAGUAR.bul # REMINGTON.BUL
4] brenneke bul 2] JLK bul |2 RWS _bul
2] CALHOON BUL 2] LAPUA bul 2| SAKO_ bul
2] COLORADO BUL ] LeadExtrusions_bul |#SELLIER_BELLOT.BUL
2] combined.bul 2] LIMA.BUL || SHILEN.BUL
i |2 DELSING.BUL 4] LOSTRIVER.BUL |#| SIERRA bul
ARH |2 DKT.BUL 4] LYMAN. BUL |# SINTERFIRE. BUL
% FEDERAL. BUL \#Mayerl_Custom € _ AFEROBUL  |#SPEER.BUL
z |# FIOCCHI.BUL |#|MEN.BUL # SWIFT.BUL
L Ter 2| FORTEK.BUL 2| Moeller.bul 2 SWISS_RUAG bul
Arbeitsplatz [ B ESCR 5|NORMA BUL |WINCHESTER BUL
] Gian-Marchet-Bullets_bul ] northfork BUL |#WOODLEIGH BUL
'2 2] GPA.BUL |2|NOSLER.BUL
4 2] GSCUSTOM.BUL & partizan _bul
WEEIERTBEEN 3] Haendler-Natermann_SPORT .bul 2] PMC.BUL
ng:
<] |

Dateiname: |ALASI<A.buI Offnen

1IN

Dateityp; IEIuIIetfiIe *bul Ll Abbrechen

Picture 24: Open Bullet File Window

» BC Fields:
= Under Projectile Selection box there are 6 entry fields to specify up to 6 BC's and 5
velocities to each bullet. Fields have to be filled from left to right, the last right
standing BC does not need a boundary velocity, it should be set to zero
» Projectile Muzzle Velocity
= Enter projectile's muzzle exit velocity. By pressing button to load data from
QuickLOAD the value is automatically overwritten.
» Bullet Weight
= Enter mass of bullet. By pressing button to load data from QuickLOAD the value is
automatically overwritten.

< FRAME Environmental Properties
» Direction of Firing (Compass deg)
= Enter direction of fire to North direction, from muzzle to target center. Angle taken
from compass, between North and line to target, clockwise increasing. North= 0 deg,
East = 90 deg, South =180 deg and West=270 deg.
» Latitude of Gunsite (South=negative)
= Latitude of Gun Position. Best use GPS data. Degrees range from 0 (Equator) to 90
deg = Pole, northern hemisphere positive values, southern hemisphere negative
values. If unknown, 40 to 50 deg is useable value for average North America or
Europe.
» Longitude of Gunsite
= Longitude of Gunsite position, values may range from 0 to 180 deg East of
Greenwich meridian and 0 to -180 West of Greenwich meridian, or even 0 to
359,9999 deg East of Greenwich meridian.

« FRAME Wind Settings
» Load from a file --> (or file name)
= Button to open file open dialog window to read a wind profile file

—wWind Settings

Click here to open file
dialogue window to load a
wind-profile file

Load fram a File =
Wind Speed [0 rgh

Wind Direction to Firing Direction [55.0 |deg 4
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» Wind Speed
= Enter the wind speed in desired units, double-click to field to open graphical input
» Wind Direction to Firing Direction
* Enter an angle of direction relative to firing direction from headwind =0°= 120'clock
over crosswind from right=90°= 3 o'clock over tailwind=180°= 6 o'clock to
crosswinds from left=270°= 9 o'clock; double-click on field to open graphical input
window.

s FRAME Atmosphere Settings:
» Drop down selection box for different atmospheres; may select from 3 choices
= Standard ICAO (up to 20 km identical to US Standard Atmo 1976)
e Actual Standard Sea Level conditions. Entry fields for barometric pressure,
relative humidity and temperature are disabled.
= U.S. Army Standard Metro (obsolete)
¢ Some BC's may be based on that data. Entry fields for barometric pressure,
relative humidity and temperature are disabled.
= Instrumental Readings
¢ Actual local readings from instruments. Corrections for other altitudes are
calculated by Std. ICAO formulas. Entry fields for barometric pressure, relative
humidity and temperature are enabled.
» Barometric Pressure
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
» Relative Humidity
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
» Air Temperature
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
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Trajectory Table Conditions Window

Gun f Ammunition

!.358 Morma Mag
Comment
TEST with URF propellant Ll

- Table Scale

Maximum Distance forTabIaISDD

Fange lhcrement |25

Table Energy Units

e

— Gunsite Data

Altitide of Gunsite |u

Gunsite Angle (up-downll) |EI

Gun Muzzle Position GEl< x IEI

Gun Muzzle Pasition GFIXy [0

Gun Muzzle Position GFlx 2 IEI

= |mx]
— lable Environment
Direction ot Firing (Compass dedg). |15 |deg
Latitude of Gunsite (Sauth=negstive) |45 |deg
Langitude of Gunsite [10.000000  |deg
- Table Atmosphere Settings
| Standard ICAQ |
Barometric Pressure |![|! 1246 |F 8
Felative Humidity |1 [
Air Tempetature |I5.Iﬁl |"'_
—Table Wind
Load from a File—» E’"!
Wind Speed |5 [mph
Wind Direction to Finhg Direction |55.D |deg
Takle Gun Canting Angle |IJ ideg

Use Sightn Data for Table |

4

Picture 25: Trajectory Table Conditions

Click here to set trajectory
table conditions to sight-in
conditions

In the previous window, all the data necessary to describe how the gun was sighted-in has been
entered and collected. Now we must specify the conditions under which the user wants to
shoot, e.g. conditions for the trajectory table and graphs. In most cases conditions will equal
Sight-In conditions, if they differ one must set up Table conditions.

E.g., gun was sighted-in at Trout Run, PA and now there is a F-Class-Match in South Africa.
How will my gun react at this Match?: Set Sight-In conditions to range and atmosphere data at
the range in Denver and Table conditions to range- and atmosphere data in South Africa (so far
known). Now calculate and look what corrections to windage and elevation are necessary.

Data fields of Trajectory Table Conditions Window from upper left corner to lower right corner:

/

< Gun/Ammunition

» Description of gun and ammunition used. Will be printed on trajectory table.

<+ Comment

» Add further comment to trajectory table. Will be printed on trajectory table.

% FRAME Table Scale (must be filled-in even for Sight-In = Trajectory)

> Maximum Distance for Table

= Enter the maximum range for table. Up to this value the calculation proceeds, so far
the projectile can reach this range. Otherwise calculation is stopped when projectile
falls below sea level, specified in QTM__.set file under section [startup] negativeY =-
20 (means -20 meters stop level)

» Range Increment

= Trajectory table distance step width. For each multiple of this value a line of data is
printed. This field's unit is initially used to define the range units.
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= [f Range Increment is set too coarse, the trajectory graphs will look somewhat
angular. Use different settings when you want to have a smooth graph or a short
table.
» Table Energy Units
= Select the energy units you like to have printed in trajectory table.
s FRAME Gunsite Data
» Altitude of Gunsite
= Enter the altitude of gunsite for which the table will be calculated
» Gunsite Angle (uphill/downhill)
= Enter the angle between muzzle level plane and line from muzzle to target center
» Gun Muzzle Position GFIX x
= Horizontal position of gun muzzle before (= +) or behind (= -) Ground-Fixed-Frames
y-z-plane, X-axis points into firing direction
» Gun Muzzle Position GFIX'y
= Vertical position of gun muzzle above (= +) or below (= -) Ground-Fixed-Frames x-z-
plane, Y-axis points upward
» Gun Muzzle Position GFIX z
= Sidewards position of gun muzzle right (= +) or left (= -) Ground-Fixed-Frames x-y-
plane, Z-axis points to the right

7
0’0

FRAME Table Environment
» Direction of Firing (Compass deg)
= Enter direction of fire to North direction, from muzzle to target center. Angle taken
from compass, between North and line to target, clockwise increasing. North= 0 deg,
East = 90 deg, South =180 deg and West=270 deg.
» Latitude of Gunsite (South=negative)
= Latitude of Gun Position. Best use GPS data. Degrees range from 0 (Equator) to 90
deg = Pole, northern hemisphere positive values, southern hemisphere negative
values. If unknown, 40 to 50 deg is useable value for average North America or
Europe.
» Longitude of Gunsite
= Longitude of Gunsite position, values may range from 0 to 180 deg East of
Greenwich meridian and 0 to -180 West of Greenwich meridian, or even 0 to
359,9999 deg East of Greenwich meridian.
s FRAME Table Atmosphere Settings
» Drop down selection box for different atmospheres; may select from 3 choices
= Standard ICAO (up to 20 km identical to US Standard Atmo 1976)
e Actual Standard Sea Level conditions. Entry fields for barometric pressure,
relative humidity and temperature are disabled.
= U.S. Army Standard Metro (obsolete)
¢ Some BC's may be based on that data. Entry fields for barometric pressure,
relative humidity and temperature are disabled.
= Instrumental Readings
e Actual local readings from instruments. Corrections for other altitudes are
calculated by Std. ICAO formulas. Entry fields for barometric pressure, relative
humidity and temperature are enabled.
» Barometric Pressure
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
» Relative Humidity
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
» Air Temperature
= Value according to standard, but corrected for altitude; real value in case of
Instrumental Readings
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< FRAME Table Wind
» Load from a file --> (or file name)
= Button to open file open dialog window to read a wind profile file

[PEA=slngs e— ' Click here to open file
oad from a ke —2 . .
. dialogue window to load a
Wind Speed [0 gk . -
S : | wind-profile file
wWind Direction to Firing Direction |55.D |deg |
» Wind Speed

= Enter the wind speed in desired units, double-click to field to open graphical input
» Wind Direction to Firing Direction
* Enter an angle of direction relative to firing direction from headwind =0°= 120'clock
over crosswind from right=90°= 3 o'clock over tailwind=180°= 6 o'clock to
crosswinds from left=270°= 9 o'clock; double-click on field to open graphical input
window.

» Table Gun Canting Angle
= Canting angle of gun for table. Unusual, but possible.

s Button Use-Sight-In Data for Table
» Retrieves data from Sight-In window and puts it into equivalent fields in Table window

NOTE: Unusual wind conditions may result in incomplete trajectory data output. The
output has stopped either when calculated array of data becomes too large to be
displayed or the output window signals an overflow by very long ranges and small range
increments. In such a case, it is possible to use all data by transferring data to Excel. The
only drawback is that data to Excel is raw format that means all data are in SI units like
meters, meters/second and many decimals behind the decimal point. However, it is
likewise easy to change in Excel everything you want.
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Displaying Results

=

“HOuick Target Unlimited = z
Main Menu Copyto... Show.  Font

When Output window Table or window Diagram is positioned in foreground the main menue
appearence changes to the above shown items. To return to standard Main Menue select Main
Menue from this menu. This menu bar is created while displaying trajectory table. When
displaying trajectory graphs, the following menu bar is shown:

Main Menu Copyto... Show.. Options...

Main Menu returns control to main window.

Menu Copy to...

I

opyto.. Show. O
Clipboard Ctrl+C
Erint Image Cirl+P
File Ctrl+5
Excel

o e W T

Picture 26: SubMenu Copy to...

The sub menu Copy to... contains the following selections
s Clipboard,
» Copies the contents of output window to clipboard; you may use the Insert or Paste
function of text- or graphics programs to paste it into foreign program.
s Print Image;
» Sends a bitmap (pixel) image of window to the default printer.
% File;

» Opens File save... dialog; you may save window contents as bitmap- or as text file.

< Excel;

» When Microsoft® Excel® (part of MS-Office) is installed on your computer, Excel opens
and the table is transferred to Excel's spreadsheet via 'Object automation'. Object
automation must be properly installed for Excel (which is done by installation of MS-
Office installer).

Menu Output Options...

| Options...

Save Trace
Delete lraces

v Grid
Hatched Vital Zone

v Marks on
Line Thick
Axis 3
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Picture 27: Output Menu Options...
Save Trace
» Stores temporarily the results of calculation (Trajectory table) in a collection of results.
Delete Traces;
» Deletes all temporarily stored calculations.
Grid;
» Axis' grid on / off
Hatched Vital Zone;
» Display zone defined in input window under "Vital height to LOS..." as gray-hatched area
on graph.
Marks On
» Displays Vertex, Point-Blank or Zero-Range marks in graphs
Line Thick
» Toggles between two different line types in graph
Axis, displays a sub menu:

Save Trace 'indow Results Window Calcula
BDelete Traces

A E 00
Hatched ¥Yital Zone

jolis
v Marks on } zfrnﬁiange
Line Thick N Si-RAnge
Axis ] Color Settings  * Primary Axis, left

Font Secondary Axis: right
: ol Beference Trace

Color settings;

» Alter axis' colors. Colors selected will also be used for printing on color printers.
(Sometimes colors visible on screen do not work with printers!)

Font

» Select new font for graph. Trajectory Table Font is selected via Main menu Font which is
shown instead of Options... menu

Menu Show...

| Show... Options..
Trajectory Table

Drag Table

Drop in Ground-Fixed-Frame

Path in Ground-Fixed-Frame

Path versus Line of Sight

Yelocity Graph

Energy Graph

Time of Flight

MOA Elevation Correction to Zero-In
MOA Azimuth Correction to Zero-In
Azimuth Deflection

Picture 28: Menu Show...

1=~ = I~ L 5 S SR

£
=

In this menu user decides what he wants to view:
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Trajectory Table

@ OuickTarget Unlimited= Table

i
Sight-IN Data : Standard ICAO Barometric Pressure : 101324.6 Pa | &

Altitude : 0.0m Temperature Hi BT o
Humidity 0% Angle of Site : 0.0 deg
Latitude of Site : 50,0344 deqg Longitude of Site : -8.5714 deqg
Direction to Target : 45.0 deqg Canting of Gun : 0.0 deg
Wind Speed : 0.0 km/h Direction of Wind : 0.0 deqg
Bullet r .224, 17, Siexrra HPBT HMatchkK 9377

Bullet Weight 1 4.99 g

Muzzle Velocity : 850.0 mfs

Twist Length : 10.0 in , Right Hand Twist

Gyroscop. Stability H 6T il

Ballistic Coefficients
BCl = 0.372, @V > 914 mfs
BC2 0.362, v > 762 mfs
BC3 0.362, @V > 518 mfs
BC4 = 0.343, @V > 0 mfs

Drag Model used : 6l
Sectional Density of Standard Projectile : 1 1b./sq.in.
File: 61-5AAMI Standard model

Sight-In Clicks: 1 Click = 0.66 cm @ 100.0 wd
Height of Sight Above Bore Axis : 8.0 om

Gun is Sighted-In at 100 m by sighting-in at level firing

Angle betw. LOS and LOD (above Angle of Site= 0 deqg.) = 0.0416922 deqg.
Fange Velo Time Enerqgy Path Path Correction to Correction to Total
city of LOS LOS Elevation for Windage for Dxop

Flight ¥ Z Zeroing Zeroing

m mfs sec hy cm cm Click HMOA Click MOA cm
| 0 850 0,0000 1803 -8,0 D) === Ssoe=s  oowmmre Snemre 0,0
| 25 828 0,0298 1713 -4.86 0,0 +25,4 +6,34 +0,2 +0,04 0,4
| 50 807 0,0604 1626 -2,1 0,0 +5,.8 +1,46 +0,1 +0,03 1,8
| 75 786 00,0917 1543 -0,6 0,0 +1,0 +0,26 +0,1 +0,01 4,0
s 100 766 0,1239 1464 0,0 0,0 0,0 0,00 0,0 0,00 7,3
i 101 765 0,1252 1461 0,0 0,0 0,0 0,00 0,0 0,00 7.4
X 102 764 00,1266 1458 0,0 0,0 0,0 0,00 0,0 0,00 7.8
| 125 746 00,1570 1388 -0,5 0,0 +0,5 +0,13 -0,1 -0,01 11,46
| 150 726 0,1910 1315 it 0,1 +1,9 +0,47 g 1,5 -0,03 17,0
| 175 706 00,2259 1244 -4.8 0,2 +2.,8 +0,095 -0,2 -0,04 23,6
| 200 687 0,2618 1177 -8.8 0,3 +a,0 +1,51 -0,2 -0,05 31,3
| 225 aa8 0,2987 1113 -14.1 0.5 +8,6 +2,15 -0,3 -0,07 40,4
| 250 649 0,33467 1051 -20,7 0.6 +11 .4 +2,85 -0,3 -0,08 50,9
| 275 631 0,37548 993 -28.,8 0,8 +14,4 +3,60 -0,4 -0,10 62,8
| 300 613 0,4160 936 -38,5 1,0 +17,6 +4,41 -0.,5 -0,12 76,3

Picture 29: Trajectory Table Window

The trajectory table shows range units according to Range Increment unit settings, energy
to Energy units and path units according to Line of Sight to Bore Centerline units as
defined in Table Setup and Sight-In window. Lines containing Sight-In range (S), Max height
above Line of Sight (M) and Zero-Range (bullet path crossing LOS=X) are marked with the
corresponding characters in the first column. Sight-In range may differ from Zero-Range
because of non-zero impact settings and/or different condition between sight-in data and
trajectory table conditions.
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Changing Graph's Appearance

Some additional functions are provided to shorten settings of graph without using menu:

Graph Window

{in)
160

120
a0

40

40 . Mouse cursor
-80
-120

-160

-200

0 200 400 600 1000 1200
Si-Range (yd) 27|
—&— 0:.308, 155, SRA HPBT Palma MK 2155 - 2800fi/sec

Picture 30: Graph showing mouse coordinates

Similar to QuickLOAD, moving the mouse cursor's crosshair over the graph's area displays
readouts of position of cursor in values and units displayed in graph.

[—{0uick Target Uriimited ™ Graph ~1o] x1|
Trajectory versus Line of Sight . _
[ Zi
{in) > !
100
JLO3
<100
-4.200
-300
.Ann
2110
Si-Range (yd)
®- 0:.308, 155, SRA HPBT Palma MK 2155 - 2800fi/sec
—HA— 1:.308, 155, SRA HPBT Palma MK 2155 - 2800f/sec

Picture 31: Changing Graph Axis' Units
Left-Clicking into the above yellow marked region (area about width and height of scale
numbers), a pop-up menu opens, allowing you to select a unit for the corresponding axis, as
you prefer. Units selected here are also used for printing. The selected units are valid for each
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type of graph separately. Time units (seconds) are not changeable. After restart of the program
default units according to settings in Sight-In and Table window are used.

ch S [=1E
Trajectory versus Line of Sight -
ZeruRanye
(m} SkRange {_;m
160 ) ; 160
120 [ 1120
B s R i e R
o 3 N
" [% Trajectory Table
1 Drag Tabla
P N (A B B 2 Drop in Ground-Fixed-Frame
oF 3 Path in Ground-Fixed-Frama 0s

SIS v 4 Path vorsus Line of Sight
§ Volocity Graph

& Encrgy Graph

7 Time of Flight

8 MOA Elovation Correction to Zero-in |
- 8 MOA Azimuth Correction to Zero In
_ 0 Azimuth Deflection

40t

-80}----

120}

-160

-200

0 200 400 600 800 1000 1200
S/-Range (yd)
®- (:.308, 155, SRAHPBT Palma MK 2155 - 2800ft/sec

Picture 32: Selecting the Type of Graph

By right clicking (right button of mouse) over the grid area the menu to select a graph type is
opened.

T L

Ln raph
versus Line of Sight

Trajectory

TemRange
{fﬂ} . Sl-Range (fﬁ)
160 r-------- e et s e :\:'_EB.E!]D,LQ:P__.__:_._.% Save Trace ey 160

S IO T L m vnd -
120 : : /r,? ; | : \x-'HLlTL'!IBI! Vital Zone ; 120

8O-

404

oLOS

-120
-160
-200
0 200 400 600 800 1000 1200
Si-Rarnge (yd)

—=— 0:.308, 155, SRAHPBT Palma MK 2155 - 2800f/sec

Picture 33: Selecting Graph Options
By right clicking outside of grid, the graph options menu pops-up.
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|_iQuck Target Ulfnted > Gezgh e -1o]x|
Trajectory versus Line of Sight gt
Lefoange
ﬁn) SHHan nli? {m,
180 160
120 ¢---- 1120
80 -} 80
401 140
0 0LOS
A0 R e 40
80 boooo |38, 155, SRAHPE | Palma MK 2155 - 2800/ sac = 150
[ : ] L : = ,
B L L i -120
-160 { 160
2200 p--semmem e } -200
0 200 400 600 800 1000 1200
Si-Range (yd)
—=— 0:.308, 155, SRA IEF‘BT Palma MK 2155 - 2800f1/sec

Picture 34: Edit Line of Legend

While mouse cursor is over a legend line and left clicking, a small window opens allowing you to
change the displayed text. Text is also printed on printer output. It can also be invoked by

pressing the corresponding number Key (0-9)

10Uk Taraet Uriiizd> Groph

=gl

Trajectory versus Line of Sight
(in)

100

{/n)

-1100

0LOS

K e

-300

0 200 400

Si-Range (yd)
—&— 0:.308, 155, SRA HPBT Palma MK 2155 - 2800ft/sec
—+— 1:.308, 155, SRA HPBT.Palma MK 2155 - 2800ft/sec

--1-100

- :-200

=300

Picture 35: Delete Legend Line and Single Trace
While mouse cursor is over a legend line and clicking right, the program assumes that you will

delete the corresponding trace. If only one trace is displayed, this function is disabled.
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Examples of Different Graphs in the Order of Menu

Drag Table Graph

[ {QuickTarger Unimited > Graph =lolxf
G1 Drag Cocfficient
{Cd) (Cd)
+0.700 ; 240700

WOEO0 1410800

+0.500 +0.500

+0 400 -4+ 400
+0.300 4+0.300
+0.200 o

40200

+0 100 +0 100

0 10 20 a0 40 50 60
Mach Number (n)

Picture 36: Drag Table graph, here G1-C4-graph

This window shows the actually used drag table, either G-table or C4-table or K;-table.

[HquickTarget Unlimited > Grapl - o] %
(51 Drag Coafficient
(Ke) (Ka)
+0.280 +0.280
+0.240 +0.240
+0.200 -4 +0.200
+0180 p-oemeerio +0.160
+0.120 +0 120
+0.080 +0.080
+0.040 f-------i-- +0.040
0 : - : : ' : 0
0 10 20 30 40 50 6.0
Mach Number (n}

Picture 37: G1 - K; Graph

Ky is old-fashioned ballistics drag representation. K - % x Ca
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[ rget Unfimited > Graph —|mf |
G171 Drag Function
(Gal) (el
+0.600 +0.600
1101 1| SRR S SRR, SRNRRN. RSTON: NS | NI SN ST . S— T,

+0400 f--- +0400

+0.300

T T 17 0N A SR SRR ISR, SO - AT S S W I I . S|

+0,200 +0.200

+0.100 +0.100

|

0 10 20 an 40 A0
Mach Numbern)

Picture 38: G1 -Function

The G-function starts for m=0 at zero. It is a function containing aside of C4 the standard air

. While C4 and Ky are dimensionless

density, standard speed of sound and the term

factors, G is not.
QuickTARGET Unlimited can use all three types of drag coefficients. The file format of external

drag coefficient files is explained in Appendix.

Drop in Ground-Fixed-Frame

10| x

Total Drop in Ground-Fixed-Frame
LeroRange
() {m)

1]
-400
15111 I OO

=-1200 ¢-- i } ; : : ! ’ : ! . -1200
-1600 -1600
2000 2000
-2400

SHIOM Frnesiadasanaasidens

-7800 i i i O s s s i f--\p-1-2800

2200 b i i i i i [ 43200
0 400 800 1200
Range(*) (m)
—m— 0. 358, 200, SRA SPRN 2800 - 730m/sac

2400

1600 2000

Picture 39: Graph of Total Drop in Ground-Fixed-Frame
Total drop from line of departure vs. range
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Path in Ground-Fixed-Frame

=, Unlirreted > Graph o [=103

Trajectory in Ground-Fixed-Frame i
(7 )

T s e o S o S I8

2000

12000

1000 1 1000

0 400 800 1200 1600 2000 2400 2800
Range(x) ()

® (0 358 200, SRA SPRN 2800 - 730m/sec

L

Picture 40: Trajectory Path in Ground-Fixed-Frame
Path with respect to gunsite level plane

Path versus Line Of Sight
=1olx]

quectory versus Line of Sight
”ﬂ) S-Range U'm

ZeroRange
Lo vertew g LUS

R e L bedid 41,00

+1.00}--i-

0LOS

-1.00 -4

--1-1.00

-2.00 p---o-i-

R G s Tl L e e 0 A e A A o s S
-4.00
-5.00 f-----i-

U .-

0 40 80 120 160

Si-Range (yd)
—=— (:.358, 200, SRA SPRN 2800 - 2720ft/sec

Picture 41: Trajectory Path vs. Line of Sight

The range-axis is the LOS (Line Of Sight). The maximum point-blank-range has been
calculated, before calculating range data. Therefore, it is possible to mark the vital zone by
gray-hatched area.
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Velocity Graph

[Zonick Target Linlimited i —lol =
Velocity
ZeroRange
(fiisec) (fizec)

2400 2400

BT ) O SN SOMNL U U CHURNE OO SNV SO SUUUNL: SOUONE: SUUURL U SN 7o

1600 11600

1200 F------ 1200

800

100

o

1200 1600 2000

Si-Range (vd)

0 400 800 2400

—=— (. 358, 200, SRA SPRN 2800 - 730m/sec

-+1800

0
2800

400

Picture 42: Velocity Graph

Energy Graph

Velocity graph of a long-range trajectory. Velocity drops up to 1900 yards by reaching the
trajectory vertex and then gains some velocity by falling to the end of range.

=] =lolx
Energy TeroRange
(f-ihs) (fi-ibs)
i |
2400 __________________________________________________________________________________________________ o 2400
1 e e e e e o= 2000
(i1 o e R e 1600
L e T e ISTER 11200
[Ty TR, R T PR SIERRE (PSR TECRI IR PREEL  FRCI. (RIS, (RN IO L. a00
400 4--- 4400
: : ; ] g ! : H
i : » U S B B S
6] 400 800 1200 1600 2000 2400 2800
Si-Range (vd)
—a— (0 358,200, SRA SPRN 2800 - 730m/fsec

This energy graph b

Picture 43: Energy Graph
elongs to the velocity graph shown above
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Time of Flight

get Unlimited > Gragh e =15}

Flight time R
ZIeroRanae
(aec) (sac)

32 132

28 128

i 420
16 16
12} 112
8 18
4t 14
0 - L 0
0 400 800 1200 1600 2000 2400 2000

Si-Range (v
—=— () 358, 200, SRA SPRN 2800 - 730misec

Picture 44: Time of Flight Graph
In time of flight, graph user may only change scale of range, but not time.

MOA Elevation Correction to Zero-In

'ji:; get Unlimited > Graph = l'l!li
Elevation Angle Correction to Sight-In Zero
(MCIA) (MOIA)
0 ~
400 - -1-400
-800 -800
1200 frommembe e -1200
L U e O e ey e e
2000 fo-mmee e -4-2000
-2400 -2400
-2000 ----- -2800
0 400 200 1200 1600 2000 2400 2800
Si-Range (vd)
—a— (. 358, 200, SRA SPRH 2800 - 730mfsec

Picture 45: MOA Elevation Correction Graph

Zero range is 2700 yards. At this range is no correction necessary, but to set zero for shorter
ranges, it is necessary to adjust the amount of MOA according to new zero-range.
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2]

raget Unlimited

(MOA)

Azimuth Angle Correction to Sight-in Zero

MOA Azimuth Correction to Zero-ln

Sraph

=lnfx]

1,12

IeroRange

(MOA)

]

-2.80

1200 1600 2000

Si-Range (vd)

—&— (358 200, SRA SPRN 2800 - 730m/sec

2400

240

-2.80
2300

Picture 46: MOA Azimuth Correction Graph

To adjust azimuth or windage for new zero-range applies the settings shown in graph. Note that
at shorter ranges, a positive correction to the right is necessary and for ranges above 1400
yards, a negative correction to the left is necessary due to either Coriolis effect or wind

influence.

Top View: Azimuth Deflection

et Lnlimited =

(im

-0.0200

-0.0200

-0.0100

Top View: Side Deflection (Wind + Coriolis)

ZeroRange
SkRange

(i)

-0.0300

-0.0200

-0.0100

+0.0100

+0.0200

+0.0300

—m—

|10 T S, TN - N
160 20 240
Si-Ranne (yd)
358, 225 SRA SPET 2850 - 2990f/sec

0LOS

+0.0100

+0.0200

+0.0300

Picture 47: Top View of Path

Top view of trajectory showing zeroed-in windage. Deviation is up to zero-range slightly to the
left, after zero to the right of Line Of Sight.
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Different Examples of Graphs

Trajectory versus Line of Sight

i)
+4.00

+2.00

-2.00 2
-4.00
-6.00
-8.00

-10.00

-12.00
0

Si-Range (yd)
—m— (0 358, 225 SRA SPBT 2850 - 2990ft/sec 100 yvd Zero
—=— 1. 358, 225 SRA SFBT 2850 - 2820ft/'sec Optimum Foint Blank
—e— 20 353, 225, SRA SPBT 2850 - 2990ft/sec 200 yd Zero

Picture 48: Trajectories for different zero-ranges

'-___'.'_.;l_l lick Targer Lnimited> Graph —|of %]
Trajectory in Ground-Fixed-Frame

(vd) (vd)

160 ' . : : H H 1 : ' ' : 160

170 S S R e B e e 1140

R L e

00 ML E AT {100

| : : : ' i :

0] S
40}/

B R S R LR e SETE AT (3 o

0 40 80 120 160
Range(X) (yd)
-& 0: Shot No.7 1/2 - 1320ft/sec - 60 deg Elevation
-8 1. Shot No.7 1/2 - 1320ft/sec - 10 deg Elevation
B 2: Shot No.7 1/2 - 1320ft/sec - 20 deg Elevation
- 3: Shot No.7 1/2 - 1320ft/sec - 25 deg Elevation
s

5 A

200 240

4: Shot No.7 1/2 - 1320ft/sec - 30 deg Elevation
5: Shot No.7 1/2 - 1320ft/sec - 40 deg Elevation
6: Shot No.7 1/2 - 1320ft/sec - 50 deg Elevation

Picture 49: Graph with different angles of departure for shotgun pellets No.7 1/2
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|~ 1Quick Targat Unlirmib raph S = %
Top View: Side Deflection (Wind + Coriolis)

(in) (in)
-0.200 : : : : e S 1 10711

0

BBl 0 LOS
T, Jo. | IR S S S

+0.200
-1+0.400
+0.600
: +0.800

+0.600
STV IBNE (N — -
+1.000
141,200
\ 141,400

+1.000
BT, e e e
+1.400 ::::::::::::::f::::?::::f:
e v s e “1+1.600

0 40 80 120 160 200 240
Si-Range (yd)
: Shot No.7 1/2 - 1320ft/sec - G0 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 10 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 20 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 25 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 30 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 40 deg Elevation
: Shot No.7 1/2 - 1320ft/sec - 50 deg Elevation

Picture 50: Top view of shotgun pellet's trajectory

Frteded

[10uick Target Urfirmited > Graph

Trajectory versus Line of Sight

ZEuRdnge

in SlRange in
( } vertex to LOS ( )

120¢

0 LOS

-120

e e s e o

-200 -

5 T I (N

0 200 400 600 800 1000 1200
Si-Range (yd)
—=— (: 308, 155, SRA HPBT Palma MK 2155 - 2800ft/sec

Picture 51: Trajectory in x-y plane under extreme wind conditions

Absolute crazy head-, tail-, up- and downwind conditions can create such an unusual trajectory.
Nevertheless, zero-range match is found at 100 yards. Those winds will blow the shooter away.
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- =t Uriirmited > Graph 2ol x|
Top View: Side Deflection (Wind + Coriolis)

7rroRanne

;| SkRange i
m n
[_zé -~ ! ) ; : ! ; Vcr‘rcx to iLDS { J

-12

0 LOS

4

1000 1200

Si-Range (yd)
—&— (: .308, 155, SRA HPBT Palma MK 2155 - 2800ft/sec

Picture 52: Top-view of extreme crosswind influence

Extreme crosswind causes extreme azimuth or windage deflection, but program corrects to
obtain zero range at 1000 yards.
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APPENDIX
Drag Table Files

Drag table files readable to the program must follow some rules. First, it should be plain ASCII

text files.

CMF , G1_McCoyBook
0 0.267719059
0.5 0.206642467
0.6 0.206642467
0.7  0.220893672
0.8  0.259575513
0.9 0.348136571
0.95 0.415320821
0.489630674
0.552743152
0.598550595
0.650465698
0.670824561
0.674896334
0.668788675
0.658609243
0.63214272
0.603640311
0.579209674
0.549689322
0.522204856
0.513043367
0.509989538

[¢)]

moURwWN=2O

WNDMNDNDN A A A A A A A
aN

» o
(S, ]

Picture 53: G1 C, file

On the left side, there is the content of the file
G1_McCoyBook.drg

The first line contains data and information. Any empty line
causes an error when reading the file. Entries in the first line
have to be separated by a comma. The first left entry tells the
program what is in the file: If the first character is a

e C the program assumes Cd values

o K the program assumes Kd values

e G the program assumes G function values.

The following two characters MF or FM tells the program the
sort order of data, MF means first Mach number and then
value, FM means first column contains value followed by Mach
number column.

The file contains two data columns. In the case shown the left
column are the mach numbers and the right one the
corresponding C4 values. Both data had to be separated by
either a space or a comma or both. The decimal point has to be
a point and no comma.

Because the reference projectile mass is 1 Ib and the diameter
is 1 inch, the sectional density is also 1. No further data is
needed.

CFM, M-80, .009446, .00782, .

028143, BRL-MR-1833 Piddington | |eft there is the

013 0 contents of file
0.13 0.189 308-M80-BRL.drg
0.129 0.594
0.137 0.77 This is the standard .30
0.18 0.9 cal NATO projectile and
0.314 0.972 because it has not 1Ib
0.45 1.001 mass and 1 inch
0.458 1.06 diameter, additional
0.43 1.295 specs are needed:
042 1.378
0.386 1.615 CFM is like above G1
0.356 1.867 specified, M-80 is
0.346 1.943 projectile's name,
0.296 2.445 0.009446 is the mass in
0.283 2.769 kg, .00782 the diameter
0.278 4 in meters, .028143 is
0.278 5 the length in meters and
BRL-MR-1833
Piddington is the source
of data.
Picture 54:

Specific Drag File for one Projectile

The first line contains order type, name, mass in kg, diameter in meters, length in meters,
source as comment. Commas must separate all 6 entries. The length of the file is not restricted.
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Wind Profile Files

Wind profiles may also be specified in a file. In case of shooting over a canyon, or when forest
or a ridge covers half of the range spans along the range wind cannot be defined by a single
wind speed and direction. The scheme for managing wind profiles is shown below:

Windlayers and Ranges

Altitude Y
Lp to & Ranges
A —
- T — 7 Range X
up to n Layers /( -
Altitude 3:infim<
Layer 2
Altitude 2

Layer 1
Range 4, Layer 1

Altitude 1 Range 3, Layer 1

“"Range 2, Layer 1

Width is not specified

Each Range/Layer space has wind components
wind Wwind wind Side Z
¥ y 7

for file layout see 'windfiles bd'
Picture 55: Scheme of Windlayers
Extension of windlayer file is .wif . All text must be plain ASCII code.

First line serves as comment. Second line has to be the first line containing data. Consecutive
lines must not contain empty lines. A data line contains five numerical values, separated by
space or a comma character. The decimal point is a dot and not a comma!

All data are in meters or meters per second units, data are separated in layers and zones. The
first zone of wind stretches from Range 1= O(meters) to Range 2 (in direction of firing or GFX X-
axis)

e The second zone stretches from Range 2 to Range 3

¢ The third zone stretches from Range 3 to Range 4

¢ The fourth zone stretches from Range 4 to Range 5

¢ The fifth zone reaches from Range 5 to infinite

Following sample contains one layer, which goes from alti1 (i.e. -1500 meters) to infinite altitude
User may define as many zones as he needs (<30000), each layer must contain same number
of zones, and zones may have different boundary ranges in different layers

Example of one 5-zone layer:

windspeeds , from Range , from lower altitude
vx1 , vyl , vz1 , Range1 1 , alti1
vx2 , Vy2 , Vz2 , Range2_1 , alti1
vx3 , vy3 , vz3 , Range3 1 , alti1
vx4 , vy , vz4 , Range4 1 , alti1
vx5 , Vy5 , vzb , Range5 1 , alti1

User may add additional layers (maximum not tested):
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Now the first layer is valid to altitude 2 and second up to infinite.
- Second Layer:

vx1 , vyl , vz1 , Rangel 2 , alti2

VX2 , Vy2 , Vz2 , Range2_2 , alti2

vx3 , vy3 , vz3 , Range3 2 , alti2

vx4 , vy4 , vz4 , Range4_2 , alti2

vx5 , Vy5 , vzb , Range5 2 , alti2

and so on...
windprofile4
0 ,+50 ,+5 ,0 , -500 This is the content of file testwindylayer.wif
o ,-50 ,-5 , 200 , -500 This causes such crazy trajectories displayed
0O ,-50 ,-5 , 400 , -500 here in the manual as examples. Valid from
0 , +50 , +5 , 600 , -500 altitude - 500 meters to infinite altitude, range 5
0 ,0 , +5 , 800 , -500 from 800 meters to infinite distance.

Picture 56: Contents of a wind profile file
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